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Overview
SeeSnake® HQ™ software allows users to:

• Collect pipe inspection media; including photos and video.

• Create “Reports” for customers.

• Organize and store pipe inspection content as “Jobs.”

SeeSnake HQ enables users to collect and view pipe inspection content 
in three ways:

1. Use a LT1000 and an attached SeeSnake Reel equipped with a pipe 
inspection camera to collect and view pipe inspection content during 
an inspection.

2. Use a SeeSnake inspection system made up of a SeeSnake Reel and 
a CCU such as a CS10 or CS1000 to perform the pipe inspection and 
to collect the information on a USB thumbdrive. Plug the USB thumb-
drive into a computer equipped with SeeSnake HQ to access the pipe 
inspection information.

3. Upload past pipe inspection content from DVDs and other external 
sources.

Note: While SeeSnake HQ allows users to upload media content from 
DVDs and other external sources to create a new Job, SeeSnake HQ can 
not only reimport the raw media in an old Job and not the entire old Job.
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System Requirements
• Windows® 7

• Intel® Pentium®, Core™2 Duo, or AMD Athlon™ 1.8 GHz or higher

• DirectX® 9 or 10 compatible graphics card with at least 256 MB

• DirectX® 9 or higher compatible sound card

• CD-ROM drive or internet connection for installation

• 2 GB system memory

• 30 GB disk space

• One USB 2.0 port

• Screen resolution of at least 1024 × 768

Note: While SeeSnake HQ only operates on PC computers using a 
Windows® operating system, Reports can be viewed on any computer.

Install

To install SeeSnake HQ, insert the installation disk into the CD or DVD 
drive and follow the onscreen prompts. Alternatively, download the most 
current version of SeeSnake HQ from hq.ridgid.com.

Jobs and Sessions
During an inspection, SeeSnake HQ gathers information and packages it 
into a “Job.” To help organize the information, Jobs can be broken down into 
subcategories or smaller units called Sessions.

As an example, during a home inspection, an inspector may start a new 
session as the camera is moved to different parts of the house, but all of the 
sessions will be listed under the same Job. 

Also, a Job at the same address can contain multiple sessions performed on 
different days. This allows an inspector the ability to group and organize all 
inspections performed for a singular customer.

Jobs and Sessions can contain the following information:

• Video

• Photos

• Job location information

• Customer information

• Text notes
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Jobs with the LT1000

When performing a pipe inspection using the LT1000 and a SeeSnake 
Reel, view the image from the inspection camera in the box labeled 
“SeeSnake Live” or click the box to minimize SeeSnake Live ” (See Item 1, 
Figure 1) and to expand the camera view in the View Port (See Item 1, 
Figure 1).

Figure 1 – SeeSnake Live View in the Job Window

1 2
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Starting a New Job

To start a new job when using a SeeSnake Reel equipped with a pipe 
inspection camera and a LT1000, perform the following functions:

1. Ensure the SeeSnake Reel has been correctly connected to a LT1000.

2. Connect the LT1000 to a computer equipped with SeeSnake HQ.

3. Turn ON the LT1000 and insert the pipe inspection camera into the 
pipe.

4. Open SeeSnake HQ and click the “New” icon in the Home Toolbar or 
select “New Job” from the File Menu to open a “Job Window.”

5. The SeeSnake Live image as seen by the pipe inspection camera will 
be shown in the “View Port” when the SeeSnake Live box is selected 
and outlined in blue in the Job “Navigator.”

Collecting Media

With SeeSnake Live selected and appearing in the View Port, use the 
icons on the right side of the Job Window to collect media and control 
media collection options. As media is captured, it will appear in the Job 
Navigator in the order captured and underneath the “Active Session” box.

Note: The LT1000 also contains similar icons on its faceplate that allow 
users to run the entire inspection from the CCU.

Taking a Photo

 Select the photo icon to take a still image picture as seen by the pipe 
inspection camera.
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Including Notes with Photos and Video

 Select the notes icon to simultaneously take a picture and include 
notes. 

To enter notes for photos or video that have already been captured, select 
the photo from the Job Navigator. The photo or video will appear in the 
View Port. Enter notes in the boxes below the photo in the View Port.

There are two options for entering notes:

1. Notes: Public notes associated with the photo can be read by the cus-
tomer and the user in the Report.

2. Private Notes: Notes associated with the photo which can only be 
viewed by the user in HQ.

Recording Video

 Press the video icon to start recording video. Press the video icon a 
second time to stop recording video.

SeeSnake HQ also enables users to pause the video. After starting a 
video, press the video icon a second time. A 5 second countdown will 
appear. Press the video icon during the countdown to pause the video. If 
the video icon is not selected, the video will stop and the red light under 
the video icon will turn OFF.

Recording Autolog Video

 Autolog videos are highly compressed files of video that results in 
a smaller file size than standard video. Autolog video recordings saves 
screen images in a motion JPEG (MJPEG) video format. Press the Autolog 
key to start and stop Autolog video.

Controlling the Audio

 When taking both standard and Autolog video, SeeSnake HQ 
automatically records audio by default. Press the microphone mute button 
to turn OFF the audio recording. The microphone mute button will turn a 
gold color when the microphone is ON.
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Controlling the Sonde

 Many SeeSnake pipe inspection systems have a Sonde built into 
the camera which transmits a 512 Hz signal. When the Sonde is turned 
ON, a locator can detect it and allow the inspector to locate the camera’s 
position underground. When the Sonde is ON, the icon will turn green and 
the Sonde icon will appear on the photo or video. Press the Sonde icon a 
second time to turn it OFF.

Rotating an Image

 If the camera rotates in the pipe, the picture can be rotated in 
SeeSnake HQ. Press the rotate image icon to rotate the image as viewed 
by the camera. 

Uploading Jobs from CS10, CS1000, and Other External 
Sources

When using a CS10 or CS1000 Jobs and subsequent sessions will be 
saved to a USB thumbdrive. When inserted into a computer, SeeSnake HQ 
will auto-import new Jobs from a USB thumbdrive by default. To turn off the 
auto-import, go to the Settings tab and remove the “×” from the auto-import 
box in the Preference section.

Upload Jobs saved on an external source such as a thumbdrive or a DVD 
to SeeSnake HQ as follows:

1. Insert the thumbdrive or other external source into a computer with 
SeeSnake HQ.

2. In the Home screen, an “Import” icon will appear in the “Job Spaces” 
section (See Item 1, Figure 2). 

3. Click on the “New” icon and right click on the Jobs to be imported and 
select, “Import Job” or “Import All.” Note: If the USB thumbdrive con-
tains Jobs which have already been imported, an “Imported” icon will 
appear in the Job Spaces.

4. Find the imported Job in the Job Space.
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Figure 2 – Job Spaces and the Home Screen

Note: The CS10 and CS1000 will automatically save photos, videos, and 
Autolog videos to the latest Job on the thumb drive. The CS10 and CS1000 
will save media files to a new session on the thumb drive. If a Job does 
not already exist on the thumb drive, the CS10 and CS1000 will open a 
new Job.

Job, Inspector, and Customer Information

There are multiple ways that an inspector can enter Job, Inspector, and 
Customer information into SeeSnake HQ. This information helps to 
organize Jobs, but will also be generated into Reports when created for the 
customer. Information can be added before, during, or after an inspection.

Manually Adding Information

1. Open the Job from the Home screen by double clicking it or by select-
ing the Job and then clicking the Open Icon.

2. In the Job Window, click the Job Info box in the Job Navigator to view 
the fields for Job information, Customer information, and Inspector 
information in the View Port (See Figure 3).

1
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Figure 3 – Entering Job, Inspector, and Customer Information in the View 

Port

3. Type the contact information into each field or select “new contact.” 

4. To enter new contact information and to also save the information into 
the Contacts List:

• Select the yellow construction hat icon in the Inspector Contact 
Information field or the house icon in the Customer Contact Infor-
mation field (See Item 1 and Item 2, Figure 3) 

• Select “new” contact from the drop-down list. 

• When closing, save the Job to automatically import the contact 
information into the Contact List.

Note: Check the box next to “Set as default inspector’ after entering new 
inspector information to automatically apply the same inspector information 
to subsequent Jobs. Change the default inspector from the contacts list.

1 2
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Adding Information from the Contacts List

Add, remove, edit, import, and view contact information by selecting 
“Contacts” from the Tools Tab of the Home screen. Automatically apply 
information saved in the contacts list to a Job:

1. Open the Job from the Home screen by double clicking it or by select-
ing the Job and then clicking the Open Icon.

2. From the Job Navigator, click the Job Info box and fields for Job infor-
mation, Customer information, and Inspector information will appear in 
the View Port (See Figure 3).

3. Click the yellow construction hat icon in the Inspector Contact Informa-
tion field or the house icon in the Customer Contact Information field 
(See Item 1 and Item 2, Figure 3). 

4. Select a contact name from the drop down list to populate the fields 
with information already contained in the Contacts List (See Item 1, 
Figure 4).

Figure 4 – Inputting Contact Information from the Contact List
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Renaming a Job

There are two ways to rename a Job:

1. From the Home screen, right click the desired job and select “Rename”

2. Open the Job and click the “Job Info” box in the Job Navigator. Rename 
the Job in the Job Information box (See Item 1, Figure 5).

Note: Renaming a Job within HQ does not rename the raw files as stored 
in the system data. Raw files will always remain as labeled by the Job date 
and time even if the Job name changes.

Figure 5 – Job Info Box

1
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Organizing and Sorting Jobs

Sort Jobs by information type as shown on the column headers in the 
Home screen. Click on a column header to switch between ascending and 
descending sorting orders.

To edit available column headers, perform the following:

1. Right click the headers area in the Home screen.

2. Select “Show/Hide Column Headers.”

3. Select or deselect various options from the drop down list.

Delete a Job

To delete a Job, move the Job into the Job Recycle bin as shown on the 
Home screen. After moving the Job into the Job Recycle bin either select 
and individually delete a Job or empty the entire Job Recycle bin.

Archive a Job

Instead of deleting a Job, which is permanent, archiving a Job allows users 
to save Jobs without cluttering the current Job workspace. Archive Jobs by 
one of the following methods:

1. Right-click on the Job and select, “Archive Job” from the drop down 
menu.

2. Select Jobs and drag the Jobs to the Archive folder in the Job Spaces.
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Reports
Reports will automatically populate from the information input from the Job 
fields in the View Port (See Figure 6 and Figure 7). 

Figure 6 – Report Example – Cover Page

Figure 7 – Report Example 
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SeeSnake HQ enables users to package and deliver information from a 
inspection session to customers in a variety of different ways.

Table 1
SeeSnake HQ Reports

Report Type Information Included

Email or Print
Photos

Text

Export*

Photos

Text

Standard video

Autolog video

DVD†

Photos

Text

Standard video

Autolog video

Upload‡

Entire Reports

Individual photos

Individual videos

*     Export as HTML or PDF to USB thumb drive
†     Can be viewed without computer.
‡     Subscribers and customers can log onto RIDGIDConnect to view content.

Individual Images or Video

Send individual images or video to customers without creating a Report by 
performing the following functions:

1. Open the Job containing the desired information to be delivered to the 
Customer.

2. Click on the photo, video, or Autolog video to be delivered and drag it 
to  the computer desktop, USB thumb drive, or other external option.

Note: By default, photos will be exported as JPG files and videos will be 
exported as AVI files.
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Frequently Asked Questions
See http://hq.ridigid.com/faq for a more inclusive list of frequently asked 
questions.

How do I copy my Jobs or files to a computer or other storage 

memory device?

• To move a Job to a storage device, plug in the device to the com-
puter and drag the desired Job directly from SeeSnake HQ onto the 
drive. On the storage drive, the copied Job will appear as a folder, 
labeled with the appropriate Job date.

How do I know when updates are available for SeeSnake HQ?

• SeeSnake HQ will check for updates automatically. To check for up-
dates manually, click “Help” and “Check for Update” from the Home 
screen.

How do I insert my company’s promotional video into a Report?

• Drag videos or photos from the computer or flash drive and drop the 
file into the SeeSnake HQ Report.

How do I add a company logo to a Report?

• Add a PNG or JPEG file with the company logo to a Report using 
one of the following two methods:

1. From within the Report, click the logo in the top-left to open a window 
which will allow the search and upload of the logo image.

2. Navigate to Tools > Settings > Report and browse for the logo image in 
the Settings area.

Can I put multiple Jobs onto a single USB thumbdrive or flashdrive?

• Yes. Move as many Jobs onto a single USB thumbdrive or flashdrive 
as allowed by the space available. Note that Jobs with longer videos 
take up greater amounts of space.
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Troubleshooting

Figure 8 – Troubleshooting Page

SeeSnake HQ contains a built-in troubleshooting tool that will help users 
configure SeeSnake HQ and the LT1000 for optimal performance. To 
access the troubleshooting tool, perform the following functions:

1. From the Home screen, click on “Tools” and select “Troubleshooting 
Tools” from the drop down list.

2. Close SeeSnake HQ when prompted.

3. Follow the on-screen instructions and prompts to help diagnose and 
resolve common issues.
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Table 2
Troubleshooting

Problem Probable Fault Solution

SeeSnake HQ 
installation freezes 
part way through

Installation being halted 
by the Windows UAC 

(User Account Control) 
verification window 

which requires acknowl-
edgement of the prompt.

Find the UAC window by 
either clicking through or mini-

mizing any open windows.

In the Taskbar, locate an icon 
(possibly flashing) that looks 

like a shield.

Trouble burning 
DVDs through 
SeeSnake HQ.

DVD burner 
malfunctioning.

Check the DVD burner for 
error.

Error with SeeSnake 
HQ.

Contact technical support to 
report the error.

SeeSnake HQ conflicting 
with pre-installed, built-in 

DVD software.

Identify and close the pre-in-
stalled, built-in DVD software. 

If allowed by the software, 
toggle the “Auto-launch” to 
“Off” within the settings.

Customer unable 
to view Reports.

Report not properly 
saved.

Ensure the Report was 
properly saved by open-

ing SeeSnake HQ and by 
navigate to the Reports tab. 
Attempt to re-distribute the 
Report to the Customer or 

attempt to re-distribute the Re-
port using a different method.

Report will not 
print.

Problems with the printer.

Ensure the printer is correctly 
connected and powered on. If 
using a network printer, check 

the network status to verify 
the connection.

Ensure the printer has an 
adequate amount of paper 

and ink.

When printing, the print dia-
logue box will open. Ensure 

that the desired printer is 
selected or set as the default 

printer.



 18 │SeeSnake HQ

Notes
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Notes


